Web Pages Made Easy

(and cooler)

With

Adobe Dreamweaver
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Part 1: Introduction
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Updated yet again for CS3 (v9)
Dann Foster

Information Technology Department

Oakton Community College

Fall 2008
Section I: Introduction

Adobe (formerly Macromedia) Dreamweaver is a very powerful and sophisticated yet intuitively designed web authoring program. Like FrontPage, it is capable of designing and maintaining entire web sites. Unlike FrontPage, 

· It allows for easy development and maintenance of single web pages

· It adheres more closely to true W3C-approved HTML coding-- no Microsoft proprietary coding.
· You can take full advantage of anything you create with Dreamweaver without needing to host the pages on a Microsoft web server

Dreamweaver is an excellent "next step" program for people who have some experience using entry-level authoring programs such as Netscape Composer. Most users find it easy to make the jump into using the basic functions and can grow into many of its higher-level features as they need them. 

Dreamweaver functions well as a standalone program but also works closely with companion programs Fireworks and Flash. These programs are available individually or as a packaged suite, often with a generous educational discount.

The materials here were originally developed to cover the basics of Dreamweaver 3.0, and were updated for CS3 for fall 2008. If you find any errors please notify the author of the handout or the leader of the workshop.
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Oh, by the way, that song going through your head right about now is "Dream Weaver," 1975 by Gary Wright. A semi-one hit wonder, he didn't do much else you'd remember though he did play keyboards on George Harrison's  'All Things Must Pass.'

Goals and Objectives 

The target learner for this material has the following entry characteristics:

· Has some experience with simple web page authoring in a WYSIWYG environment

· Can function comfortably in a networked Windows environment

· Understands web page saving/storing at Oakton

· Has a basic knowledge of HTML markup concepts

This document is intended to introduce learners to 

· The basic layout of Dreamweaver

· The essential functions of Dreamweaver needed for creating simple web pages

Upon completion, the learner will be able to 

· create a simple web page using such elements as

· Text, tables, images and links

· locate and launch key features of Dreamweaver, such as

· Drop menus, popup menus, properties palettes and object palettes

Starting Dreamweaver on Oakton's network (in XP)
1. Click the Start menu (lower left corner of computer desktop)

2. Click on All Programs

3. Click on NAL 

4. Click on Graphics Software 
5. Click on Web Design

6. Click on Adobe Dreamweaver CS3
Note: You may also launch a web browser at this time.

The first time you launch Dreamweaver CS3 on a particular computer you mush choose the workspace setup. (You may change it later under Edit Menu > Preferences > General > Change Workspace.)

1. For this workshop, choose “Designer”

2. Click OK. 
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Section II: Dreamweaver Layout (“Workspace Elements”)
About the Workspace

This view is typical of (former) Macromedia software in that the main work area is a separate window from other windows containing your tools. These windows are called Panels (sometimes called “palettes,” a reference to older versions of the program; that term may be used at times in this document).
Initially Dreamweaver will launch the Document Panel surrounded by several tool panels.  For purposes of this introduction, we will close all but the Document, Objects, and Properties panels.  
The Dreamweaver Document Window Panel
Dreamweaver initially launches the main Document Window in basic WYSIWYG view. The Document Window is your canvas where you lay out and/or modify the contents of your web page.  It is framed by toolbars and tool panels.
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Key Features:
· View (upper left) allows authors to see HTML code only, WYSIWYG only, or split the window between the two—changes made in one will be immediately reflected in the other.

· Tool bars and menu bars at top of screen
· Page Dimensions and Download Estimates: 800 by 600 is standard pixel size. 
Menus and Panels Overview

Dreamweaver allows access and modification of most all features and functions via either its menus (File, Edit, etc.) or "Panels," small windows independent of the main Document Window that can be revealed or hidden as desired.
In addition, Dreamweaver provides "Context Menus." These pop up when you right-click on an object in your web page, such as a table or a graphic, to give you quick access to commands specifically applicable to that object.

The image below shows the Document Window surrounded by the more commonly used tool panels. 
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Opening and closing individual Panels:

If a desired panel is not in view, 

1. Click on the Window menu.

2. Choose the desired palette from the drop menu

3. Close by clicking the "X" in a palette's upper right corner.

Tip: You can toggle all the panels off and on together using the F4 key.
What the Panels do
Palettes provide convenient access to commands used for higher-end coding and multi-page web sites. As you become more skilled you will likely use more and more of them. The following is a brief overview of the two most necessary to the new web author – The Objects palette and the Properties palette. 
	The Objects Panel (AKA “Insert Bar”)
This panel largely echoes choices also found on the Insert Menu. 

Groups of related objects are placed under a tabbed heading. Clicking different tabs reveals different groups of objects.
Pictured below is the "Common" objects panel. 
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The Common Objects panel, like its name implies, includes the most commonly needed functions for newer users, including: 

· Images 

· Rollover images & Navigation Bars

· Tables

· Horizontal rules

· Links See also p.14 for alternative mailto: method

· Flash, Shockwave, java applets, etc.

Note: Hovering the mouse over an icon will pop up the name of that icon.

Other groups of objects include:

Layout: Table, layer and related tools for page layout.

Forms: The elements that make up an interactive form such as check boxes.

Data: Insert data objects and other dynamic elements
Spry: Insert Spry Network javascript-related elements
Text: Text style tools, many of particular importance to accessibility
Favorites: A view that can be totally customized—user’s choice of tools.


The HTML objects are no longer available. Use either the Tag Chooser on the Common Objects bar or the Text objects panel for text-specific code.
The Properties Panel (AKA “Property Inspector”)
Properties may be the most frequently used of these tools. With this you can create and modify such things as text, tables and images. The tool is context sensitive. The options will change depending on the object selected (in the Document Window) to modify.

The upper and lower halves of each contextual view can change depending on the action being taken but both halves will always generally relate to, and work together on, a specific type of element.

In the view below, Properties is set to modify selected text (this is also the default view).
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In this next view, the panel is set to modify an image. Note the thumbnail of the selected image appearing in the upper left corner.
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Finally, we see the panel set to modify the look/structure of a table.
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Section III: Creating Basic Web Page Elements

Dreamweaver's basic authoring functions are quite straightforward though manipulating the properties of basic elements, such as tables and images, may be a little less obvious. 

In this section, to cover the basic functions, we will create a simple personal home page with the following elements:

· Text

· Table

· Image

· Hyperlink

· Mailto: link

· Background color

Note: SAVE YOUR PAGE NOW.  Saving a page before inserting elements helps avoid prompts for defining full web sites and will help keep the code references calling for links and images relative to the document.

Working with Tables

Tables can be used in web pages to layout and hold in place other elements such as text and images. Note: While the trend has been toward using tables only for actual "tabular data" due to accessibility concerns, using tables for layout will not make your page inaccessible to people with disabilities. For more information on accessibility issues, including working with tables, go to http://www.oakton.edu/~dannf/webaccess.htm.

To insert a table:

1. [image: image46.png]


Click the Table icon near the top of the Objects (common) panel.
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2. The Insert Table dialogue window will 

appear.


Here you can select the initial settings for your table (Dreamweaver makes it easy to alter the settings later on using the Properties palette.)

3. In the dialog window, set the number of rows or columns by dragging the curser across the number and typing a new number. 

· Choose 3 Rows and 2 Columns 

4. The other settings may be adjusted as desired:

· Table width can be changed after inserting by dragging the table's edge border.

· A border setting of 0 means browsers will display no cell border lines

· Cell Padding and Spacing both essentially increase the spacing between cell contents, 0 being tightest, 7 or 8 being pretty loose. The differences matter little with invisible tables.
5. Defining Header cells in the table is important for data tables (ala spreadsheet type data). Not necessary for layout tables.

6. Accessibility

· Captions will appear as text above the table. Captions should briefly describe the purpose of a data table. 
· Summaries are longer descriptions of the purpose and/or structure of the table contents. Summaries are hidden in the table code and do not show in the design view.

7. Click OK. Your table should appear in the document window.

[image: image48.png]


Adjusting Table Dimensions

When your table first appears in the document window, it will have "handles" (small tabs) on the bottom and right edges which show that the table has been selected and can be modified. 

· You may adjust the height and width of the table by dragging the handles with the mouse.

· Table height and column width (not the overall table width) usually will increase automatically to hold whatever you place in a cell.

· The handles will disappear (and the table will be unselected) when you click inside a cell or outside the whole table

Modifying Table Properties

Some table properties are adjusted using the Properties Palette; others are adjusted using the Modify/Table menu.  Many can be done either way. Methods for modification offered below are "author's (that's me) choice" but should allow the new Dreamweaver user the most control with the fewest headaches.

· To use most of the choices on the Modify/Table menu, first click anywhere inside the table (otherwise most of the choices will be grayed-out)

· To use the Properties Palette you must first select the table
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To select a table:

1. Click anywhere inside the table

2. Click on the Modify Menu

3. Click on Table

4. Click on Select Table

· With the table selected, the Properties Palette will change to the Table Properties view

Other means of selecting a table include
· Clicking in a cell then clicking the <table> in the Tag Selector (bottom left of  the document window)

· Dragging the mouse pointer across the table

Adding Rows and Columns

The Modify/Table Menu includes a selection called Insert Rows or Columns. Unlike "Insert Row" and "Insert Column," this choice gives you more control over where the column or row is placed and allows for inserting multiple rows and columns in one step.

To use this command: 
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Click anywhere inside a table. 

2. Click on 
the Modify Menu
then Table
then Insert Rows or Columns
A dialogue window will appear
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3. Choose either Rows or Columns

4. Choose the number of Rows or Columns to insert

· You can type a number in the field or use the up/down arrows to change the number

5. Choose whether you wish the new row(s) or column(s) should be inserted

· For this exercise, click in the bottom row and choose to insert 1 row, Below the Selection.

6. Click OK

The Dialog window should close and the table should show an additional row.
To Delete a Row:

1. Click a cell in the undesired row

2. Chose Modify (menu)

3. Choose Table

4. Choose Delete Row

Modifying Table Layout using the Properties Panel
With the table selected (the "handles" should be showing on the top and right sides), the Properties Palette will change to the table properties view.
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In this view, you can change the following common layout features (others will be covered in later lessons):

	
	

	· Height & width. Set the width of the whole table in terms of pixels or percent (the percent of the browser window). Height code is now deprecated so DW no longer includes the setting on the properties panel (but it can be adjusted in the source code)
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	· Table alignment. Use the drop menu in the upper right to set whether the table will be centered or moved to the right or left side of the page
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	· Border width. Type a number from 0 (no border) to 5 or 6 (for a thicker border)
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	· Background image. Type the name of the file (if it's local) or click on the yellow file icon to locate and chose the filename.
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	· Background color. Type a hex code in the field or click the lower right of the box as shown to pick from a color palette. This command will affect all the cells of the table if the whole table is selected. Otherwise it applies color to individual cells.

Note: For painting a color across some, but not all, of the cells in a table you may experiment with coloring the table and/or page background colors vs individual cells.
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	· Border Color. Type a hex code in the field or click the lower right of the box as shown to pick from a color palette. This command will affect all the cells of the table if the whole table is selected. Otherwise it applies color to individual cells.
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Merging & Splitting Cells

For more flexibility in page layout, Dreamweaver makes it simple to merge neighboring cells in the same row or same column into a single, larger cell and to split one cell into two separate cells. This is often handy, for instance, in placing a wide banner graphic into the top row of a multi-column table.
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To merge 2 or more cells:
1. Select the desired cells to merge

2. Click the Merge Cells icon near the lower left of the Properties panel.

For the home page exercise, merge the middle and lower cells of the left column
To split a cell:
1. Click the cursor into the desired cell

2. Click the Split Cells icon to the right of the Merge icon.

3. In the dialog window, choose the number of cells to split the original into
For the home page exercise, spit the cell that is in the right column, second from top, in two.
Working with Text

Text - Inserting 

As with most web authoring programs, the essential method of inserting text with Dreamweaver is this

To insert text:

1. Click somewhere on the page.

2. Type.

3. When finished, stop typing.

You can also copy and paste from most any other text-based document but the result is a pretty boring chunk-o-text. Text must be formatted to achieve a more interesting look and easy-to-read layout.

For the home page exercise and use the table we created to contain the 'header' information. Type the following text (substitute your personal information if desired) in the far right cell of the 2nd row:

Note on Line Breaks: Pressing Enter will give you a double-space between lines. Shift-enter will single-space.

John Smith, PhD.

Professor of Webology

Room 1234

Phone x5678

Email: jsmith@oakton.edu

Your page should now look something like this (don't worry if the cell widths don't match... yet).
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As it is with word processing, what you type will appear to be in Dreamweaver's default font-- generally Times Roman or Arial. This does not impact how the text will ultimately look in a web browser. If text is left unformatted, a web browser will apply its own default.  (Even after formatting, it is still possible for a browser to override.)

Text - Formatting

Text formatting (e.g., size, typeface, color, etc.) can be accomplished in a number of ways. More sophisticated web sites will use Style Sheets for much of this. Style Sheets are a set of commands that control the look and layout of web pages. Depending on how they are used, they can be applied to multiple pages or a portion of a single page.  Though Style Sheets are beyond the scope of this introductory document, they are becoming standard and are worth learning as your skills and interest progress.

The most common way to format text in simple web pages is to apply formatting commands to individual words, phrases or lines of text. This is done by selecting the text and using the Properties palette to make changes. 
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 To format text:

1. Drag the mouse across the desired text to select it.

2. Use the Properties Palette to change the text appearance. If you are formatting text in a table cell, the Properties palette will show text commands on the upper half of the palette and table/cell commands in the lower half.
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Key to formatting commands on the Properties palette:

	· Paragraph/Heading. If you are formatting a line of text that is essentially a headline introducing a section of the document, choose one of the Heading sizes from the drop menu. The appearance will be similar to choosing a text size, but headings provide structural markup to the document-- which browsers for disabled users depend on.
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	· Font style. "Default" applies no style and leaves the appearance up to the browser when the page is displayed. Because the success of declaring a font style requires that other people's computers have that font installed, the five main choices on this list are pretty safe for most browsers. Each of the five selections has a 2nd and 3rd choice that will be applied if the preferred font is unavailable.
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	· Text color. Type a 6-digit hex code into the text field or click on the small down arrow near the upper left to reveal a color palette. The mouse pointer becomes an "eyedropper" that can choose a color from the color palette or can be pointed at an element (text, image, etc.) on the web page to duplicate its color.
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	· Bold and Italics. Functions like most word processors. Choose one or both to apply that style to selected text.
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	· Alignment. Selected text can be left-justified, centered or right-justified.
	[image: image19.png]




	· Bullets and numbers. Select multiple lines of text then click one of these to make the list bulleted or numbered. To add to the list later, place the cursor at the end of a line and press the Enter key. Note that if you wish to format numbers and bullets, you may do so by going to the Text Menu and clicking on "List."
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	· Indent/Outdent. Selected text will be moved left or right.
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	· Text size. Drop menu of relative text sizes. 
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	· Alignment within a cell. Click in the desired cell and use the Horizontal and Vertical Alignment drop menus on the Properties panel to set how everything in the cell aligns. Commonly, text will be aligned ‘top’ and ‘left.’ 
· (You can also drag the mouse from one corner cell to the opposite corner, selecting all cells, and THEN set the alignments for all the cells at the same time.
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Continuing our little exercise...

Suggested formatting for the Home Page header text.

	1. Select "John Smith, PhD." by dragging the mouse across the text.
	

	2. Click on the Size drop menu on the Properties palette and choose "+2"
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	3. Click on the Color palette and use the eyedropper to choose a color
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	4. Click on the Bold button on the Properties palette
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The selected text should now be a little larger, bolder, and have a different color than the rest of the text in the cell.

Working with Links

Creating Hyperlinks

There are two important types of links for a simple web page: 

· A link to another page.

· A "mailto" link. Mailto links will pop up an email composition window pre-addressed to whoever the author desires (though usually himself)

These are created in similar ways, though the differences are important.

To create a link to another page:

For this exercise, first type "Link to Yahoo" and "Syllabus" in the left column, 2nd cell from top. We will pretend that John Smith has a second web page located in the same folder as his home page called "syllabus.htm."
1. Select the text "Link to Yahoo" by dragging the mouse across it.
2. In the Properties palette, type "http://www.yahoo.com" in the Link field.

3. Select the text "Syllabus"

4. In the Properties palette, type "syllabus.htm" in the Link field

Above we see examples of two types of page links: Absolute and Relative. An absolute link is one that contains the entire URL of a page; a relative link is one that contains just enough information to locate the page relative to the current page. Generally speaking, when linking between two web pages stored in the same folder, authors may use a relative link which contains only the name of the web page file, such as "syllabus.htm."

For more information, see the document "Understanding Relative and Absolute URLs." (See the list of online resources at the end of this tutorial.)

Creating a Mailto Link

To create a mailto link:

1. Select the text containing the email address by dragging the mouse across it.





2. Click the ‘mailto’ icon on the objects panel





3. In the Properties panel's Link field, type "jsmith@oakton.edu" (no spaces).


· Don’t include “mailto” when using this method. Dreamweaver will insert mailto: into the HTML source code. 


Working with Graphics

Inserting Images

With Dreamweaver, it is simplest to save your web page before inserting graphics or other files. Dreamweaver 'likes' to know where the graphics are in relation to the web page (see note on page 7).  Graphics can be in the same folder as the web page or reside on a different server-- the only real difference is how the link will be structured to show its location in relation to the page. 

For this homepage exercise we first need to find two images to experiment with. 

1. Use a browser to go to http://www.oakton.edu/resource/it/personalpages/ ; a list of image files will appear. Included are logos and portrait shots.
2. Preview images by clicking on the file name (use the back button to return to the list)

3. You will need to download ONE of the logos and ONE of the portraits. (If you have a picture of yourself, you may substitute it now or later.)
4. To download a picture

a. Right-click on the desired image

b. Choose ‘Save image as…’ from the popup menu

c. Save the image to the same folder your web page is in. 

For the Home page exercise, insert a logo in the upper right cell and a portrait in the middle cell of the 2nd row.
To insert an image:

1. Click in the desired cell of the table

2. Click on the Insert Menu and choose Image

3. The Select Image Source dialogue window will appear

4. In the dialog window, navigate to the folder containing the desired images (this window works like any other Windows 'File Open' dialogue). If you have defined a web site within Dreamweaver, you may also click the Site Root button to jump to image files you’ve saved there
5. Click on the desired filename to select/ highlight it.

6. Click the OK button.

Note For pages to be saved to your public folder at Oakton, a string like file:///H|/smithpic.gif  in the URL field means the picture would not be accessible to most people. Actually it's more complicated than that. If you're new at this, just make sure the web page file and the image file are in the same (public.www) folder and you'll be fine.


If you were successful, your page’s 2nd row should look something like this:

Repeat the previous six steps to insert additional images.

Images - Alignment and other adjustments


With an image selected ("handles" showing), the Properties palette changes to image mode and adjustments can be made to such things as alignment (relative to other elements), size, etc. Images that reside in a table cell may also be aligned using commands applied to the cell.

Below are some of the more common actions.

For vertical or horizontal alignment within a cell, click inside the cell without selecting the picture and choose from the H/V drop menus on the table Properties palette.

Horizontal alignment commands can be applied to the image (in a cell or elsewhere on the page), by selecting the picture and clicking an alignment choice from the Image Properties palette.


Image size. While best resolution and preservation of the aspect ratio is achieved by actually editing a picture to the desired size in a program like Photoshop or Fireworks, the display dimensions can be adjusted by selecting the image and dragging one of the handles. The new dimensions will show on the Image properties palette. You may also type the width and height in these fields rather than drag the handles.

Alt text tags should be applied to all images on a web page. The alternative text will show in a browser if the images are turned off. To add alt tags, select the picture and type a short descriptive title for it in the Alt text field on the Properties panel.
Section IV: Key Dreamweaver Newbie Tips and Tricks

Editing HTML code 
At some point most fearless web authors need to delve into the actual HTML code, either to see what's going on or to make a correction. Dreamweaver makes it quick and easy to switch between WYSIWYG view and HTML code view.

View and edit the HTML code by either of these methods:

· Press F10 to open a separate code window
· Change from the Design (WYSIWYG) tab to either the Source or the Split tab. You can flip between different tabs as often as you wish.

Tip: If you are interested in the code behind a particular page element (image, text, etc.), click the curser on it in Document window before switching to the code view.

To close the separate HTML edit window, click on the X in the upper right corner. 

Page Properties

Easily overlooked, Page Properties is the place for setting several key features for any web page, including title, color schemes, and backgrounds.

To launch page properties:

1. Click on the Modify Menu

2. Choose Page Properties

3. Highlight a category on the left to adjust its properties.
Appearance 
Appearance actually creates a local style sheet declaring the default font, size, color, etc. These can be overridden once set.
Page Colors - Backgrounds, text and links:
By default, Dreamweaver sets the background of a web page to solid white (hex code "#FFFFFF").  

Choosing a Background Image to tile across a page background will override the background color choice. Set the image by clicking on browse and choosing it from the Select Image Source dialogue window. Images should be in your public folder.
Headings

Sets appearance settings for the H1 through H6 headings that provide structural markup to a text-heavy web page.

Links  
The color scheme of backgrounds, text and links can be reset by clicking on the to launch the color palette. Note that default colors are best for usability and accessibility.

Title/Encoding
“Title” is the text that appears in the blue bar running across the top of a browser when your page is in. It is also the text under which a page is bookmarked and which provides the most important information for cataloging your page to search engines.  Your "Title" should be a VERY brief description of your page, such as "OCC - Professor Smith Home" or "OCC - Webology Department" 

Encoding declares the numeric representation for text characters for a specific language. Just make sure it says “Western European” and forget about it. ( 

Tracing Image

An overlay image created outside Dreamweaver and are used by some for page layout. 

Clean up Word HTML (on the Commands menu)
Corrects poor or proprietary HTML code resultant of creating web pages with Microsoft Word. 

Previewing a page in a browser window

Press the "F12" key to view your page in an actual web browser window.

Online Resources
Samples for the Exercises in this handout
Faculty Home Page 2004: http://www.oakton.edu/resource/it/personalpages/sample.htm
Logos & People Images: http://www.oakton.edu/resource/it/personalpages/
Other:

Faculty Web Page How-to Guide: http://www.oakton.edu/resource/it/templateintro.htm

Web Page Templates: http://www.oakton.edu/resource/it/templates.htm

Word and Web Pages: http://www.oakton.edu/resource/it/word97andwebpages.pdf

Web Accessibility: http://servercc.oakton.edu/~dannf/webaccess.htm

Relative & Absolute URLs: http://www.oakton.edu/resource/it/relativeurls.doc

Dreamweaver Support Center: http://www.adobe.com/support/dreamweaver/
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